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Introduction

Les diagrammes et les graphiques sont souvent des moyens puissants de transmettre de 
l'information au lecteur. LibreOffice Calc propose une variété de formats de diagrammes et de 
graphiques pour vos données.

Avec Calc, vous pouvez personnaliser vos diagrammes et vos graphiques de manière très 
poussée. Toutes ces options vous permettent de présenter vos informations de la manière la 
meilleure et la plus claire.

Créer un diagramme

Pour faire la démonstration de la méthode pour réaliser des diagrammes et des graphiques dans 
Calc, nous allons utiliser la petite table de données de la Figure 1.

Figure 1 : Table de données pour les exemples de diagrammes

Pour créer un diagramme, mettez tout d'abord en surbrillance (sélectionnez) les données à inclure 
dans le diagramme. Il n'est pas indispensable que la sélection soit une plage contiguë, comme 
dans la Figure 2 ; vous pouvez également choisir des cellules individuelles ou des groupes de 
cellules (colonnes ou lignes). Voir Chapitre 1 (Introduction à Calc) pour plus d'informations sur la 
sélection des cellules ou des plages de cellules.

Figure 2 : Sélectionner les données pour un diagramme

Ensuite, ouvrez la boîte de dialogue de l'Assistant de diagramme avec l'une des deux méthodes :

• Choisissez Insertion > Diagramme dans la barre de menus.

• Cliquez sur l'icône Diagramme dans la barre d'outils Standard.
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Figure 3 : Insérer un diagramme depuis la barre 
d'outils Standard

Chaque méthode insère un diagramme par défaut dans la feuille, ouvre la barre d'outils Formatage 
dédiée et l'Assistant de diagramme, comme illustré Figure 4.

Astuce

Avant de choisir l'Assistant de diagramme, placez le curseur n'importe où dans la 
zone de données. L'Assistant de diagramme discernera généralement correctement 
la plage de données. Faites juste attention à ne pas inclure le titre du tableau de 
données.

Figure 4 : Assistant de diagramme, Étape 1 - Choisir le type de diagramme

Choisir le type de diagramme
L'Assistant de diagramme affiche l'aperçu d'un exemple de diagramme lié à vos données. Ce 
diagramme se met à jour pour refléter les changements effectués dans l'Assistant de diagramme.

L'Assistant de diagramme comporte trois grandes parties : une liste d'étapes mises en œuvre pour 
paramétrer un diagramme, une liste de types de diagrammes et les options pour chaque type de 
diagramme. Vous pouvez à tout moment revenir à l'étape précédente et changer les sélections.
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Calc propose un choix parmi dix types de diagrammes de base, avec quelques options pour 
chaque type. Ces options changent selon le type de diagramme que vous choisissez. 

Les premiers éléments de choix sont les diagrammes à deux dimensions (2D). Seuls certains 
types où la 3D est applicable (Colonne, Barre, Secteur et Zone) vous donnent l'option de 
sélectionner un rendu 3D.

Dans la page Choisissez un type de diagramme (Figure 4), sélectionnez un type en cliquant sur 
son icône. L'aperçu se met à jour à chaque fois que vous sélectionnez un type de diagramme 
différent et fournit un rendu très fidèle du diagramme final.

La sélection courante est en surbrillance (affichée avec un contour) dans la page Choisissez le 
type de diagramme. Le nom du diagramme est affiché juste en dessous des icônes. Pour le 
moment, choisissez le diagramme Colonne et cliquez sur Suivant.

Modifier les plages de données et les étiquettes des axes
Dans l'étape 2, Plage de données, vous pouvez corriger manuellement toutes les erreurs 
éventuelles que vous avez commises en sélectionnant les données.

Dans cette page, vous pouvez également changer la façon dont vous tracez les données en 
utilisant les lignes, plutôt que les colonnes, comme séries de données. C'est utile si vous utilisez 
un style de diagramme comme Secteur pour afficher vos données.

Enfin, vous pouvez choisir d'utiliser la première ligne, la première colonne, ou les deux, comme 
étiquettes des axes du diagramme.

Figure 5 : Modifier les plages de données et les étiquettes des axes

Vous pouvez confirmer ce que vous avez fait jusque-là en cliquant sur le bouton Terminer, ou 
cliquer sur Suivant pour modifier plus de détails dans le diagramme. 

Cliquez sur Suivant pour examiner l'ensemble des options disponibles à apporter au diagramme 
en utilisant les autres pages de l'Assistant.

Sélectionner les séries de données
Dans la page Séries de données, vous pouvez déterminer précisément les données que vous 
voulez inclure dans votre diagramme. Vous avez peut-être décidé que vous ne vouliez pas inclure 
les données pour les canoës. Dans ce cas, mettez en surbrillance Canoës dans le champ Séries 
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de données et cliquez sur Supprimer. Pour chaque série de données énumérée, sont spécifiées 
les plages de données pour son nom et ses valeurs Y. Ceci est utile si vous avez des besoins très 
particuliers pour les données de votre diagramme, et pour alors inclure ou omettre ces plages.

Figure 6 : Modifier les séries et les plages de données

Astuce
Vous pouvez cliquer sur le bouton Sélectionner  à côté du champ Plage pour 
Nom pour travailler directement dans la feuille. C'est pratique si vos plages de 
données sont grandes ou masquées par l'Assistant.

Une autre façon de tracer des colonnes de données non adjacentes est de sélectionner la 
première série de données et de sélectionner ensuite les séries suivantes en gardant appuyée la 
touche Ctrl. Vous pouvez saisir également les colonnes dans les zones de texte. Les colonnes 
doivent être séparées par des points-virgules. Ainsi, pour tracer B3:B11 avec G3:G11, saisissez la 
plage de sélection B3:B11;G3:G11.

Les deux séries de données que vous sélectionnez doivent être dans des colonnes ou des lignes 
séparées. Sinon Calc supposera que vous faites un ajout à une même série.

Cliquez sur Suivant pour gérer les titres, les légendes et les grilles.

Ajouter ou modifier les titres, les légendes et les grilles
Dans la page Éléments du diagramme (Figure 7), vous pouvez donner à votre diagramme un titre 
et, si besoin est, un sous-titre. Utilisez un titre qui attire l'attention des lecteurs vers le propos du 
diagramme : ce que vous voulez qu'ils voient. Par exemple, un titre plus judicieux pour ce 
diagramme pourrait être Résultats des locations de bateaux et autres équipements nautiques au 
1er semestre.

Il peut être intéressant d'avoir des étiquettes pour l'axe X ou l'axe Y. C'est l'endroit où vous donnez 
au lecteur une notion comme la proportion de vos données. Par exemple, si vous mettez Milliers 
dans l'étiquette de l'axe Y de votre graphique, cela change entièrement la signification de votre 
diagramme. Pour faciliter l'analyse des données, vous pouvez également afficher les grilles des 
axes X ou Y en cochant les options Afficher les grilles.

Vous pouvez omettre la légende, l'inclure, la placer à gauche, à droite, en haut ou en bas.

Pour confirmer vos sélections et terminer le diagramme, cliquez sur Terminer.
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Figure 7 : Titres, légendes et grilles

Note

Le bouton Terminer ferme l'assistant, mais le diagramme reste en mode Édition 
dans lequel vous pouvez continuer de le modifier. Cliquez en dehors du diagramme, 
par exemple dans une cellule du tableau, pour terminer effectivement la création du 
graphique.

Modifier les diagrammes

Après avoir créé un diagramme, vous pourriez souhaiter le modifier. Calc fournit des outils pour 
changer le type de diagramme, les éléments, les plages de données, les polices, les couleurs et 
bien d'autres options, via les menus Insertion et Format, les menus contextuels (clic droit) et la 
barre d'outils Formatage dédiée.

Changer le type de diagramme
Vous pouvez changer le type de diagramme à tout moment. Pour ce faire :

1) Éditez tout d'abord le diagramme en le double-cliquant. Le diagramme devrait être 
maintenant entouré par une bordure grise.

2) Puis utilisez l'une des possibilités suivantes :

• Choisissez Format > Type de diagramme dans la barre de menus.

• Cliquez sur l'icône Type de diagramme  dans la barre d'outils Formatage.

• Faites un clic droit dans le diagramme et choisissez Type de diagramme.

Dans chaque cas, une boîte de dialogue similaire à celle de la Figure 4 s'ouvre. Voir page 
6 pour plus d'informations.

3) Sélectionnez le nouveau type de diagramme

4) Cliquez sur OK.

Ajouter ou supprimer des éléments du diagramme
La Figure 8 et la Figure 9 montrent les éléments des diagrammes 2D et 3D.
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Le diagramme 2D par défaut comprend seulement deux de ces éléments :

• La paroi du diagramme contient le dessin du diagramme affichant les données.

• La zone de diagramme est la zone entourée de gris autour du dessin du diagramme. Le 
titre du diagramme (optionnel) et la légende se trouvent dans cette zone.

Figure 8 : Éléments d'un diagramme 2D

Le diagramme 3D par défaut comporte aussi un plancher de diagramme, qui n'est pas actif dans 
les diagrammes 2D.

Figure 9 : Éléments d'un diagramme 3D
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Vous pouvez ajouter d'autres éléments en utilisant les commandes du menu Insertion. Les 
différentes options ouvrent des boîtes de dialogue dans lesquelles vous pouvez préciser les 
détails.

Les boîtes de dialogue pour les Titres, la Légende, les Axes et les Grilles sont suffisamment 
explicites. Les autres sont un peu plus compliquées, nous allons donc les examiner ci-dessous. Il 
est également possible d’ajouter des objets de dessin, comme expliqué page 22.

Étiquettes des données
Les étiquettes des données apportent de l'information pour chaque point de données dans le 
diagramme. Elles peuvent être très utiles pour présenter des informations détaillées, mais vous 
devez prendre garde à ne pas créer un diagramme trop confus.

Éditez le graphique comme décrit ci-dessus et choisissez Insertion > Étiquettes des données. 
Les options sont les suivantes :

Figure 10 : Boîte de dialogue Étiquettes de données

Afficher la valeur sous forme de nombre
Affiche les valeurs numériques des points de données. Quand elle est cochée, cette option 
active le bouton Format de nombre.

Format de nombre
Ouvre la boîte de dialogue Format numérique, où vous pouvez choisir le format des nombres. 
Cette boîte de dialogue est très similaire à celle pour formater les nombres des cellules, telle 
que décrite au Chapitre 2 (Entrer, modifier et formater des données).

Afficher la valeur sous forme de pourcentage
Affiche la valeur de pourcentage des points de données dans chaque colonne. Cochée, cette 
option active le bouton Format de pourcentage.

Format de pourcentage
Ouvre la boîte de dialogue Format numérique pour valeur en pourcentage, où vous pouvez 
sélectionner le format du pourcentage.

Afficher la catégorie
Affiche les étiquettes de texte des points de données.
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Afficher le symbole de légende
Affiche les icônes de légende près de chaque étiquette de point de données.

Séparateur
Sélectionne le séparateur entre les étiquettes (si au moins deux options ci-dessus ont été 
cochées).

Placement
Sélectionne l'emplacement des étiquettes de données par rapport aux objets.

La Figure 22 page 24 montre des exemples de valeurs en texte (ni Afficher la valeur sous forme 
de nombre, ni Afficher la valeur sous forme de pourcentage ne sont cochées) et de valeurs en 
pourcentage, ainsi que des valeurs de données utilisées à la place de la légende ou en 
conjonction avec elle.

Courbes de tendance
Quand vous avez un ensemble de points dispersés dans un graphique, vous pouvez vouloir 
montrer la relation entre les points. Une courbe de tendance est ce dont vous avez besoin. Calc 
dispose d'une bonne sélection de types de régressions que vous pouvez utiliser pour les courbes 
de tendance : linéaire, logarithmique, exponentielle et puissance. Choisissez le type qui se 
rapproche le plus du passage entre tous les points.

Pour insérer des courbes de tendance pour toutes les séries de données, double-cliquez dans le 
diagramme pour entrer en mode édition. Choisissez Insertion > Courbe de tendance, puis 
cochez le type de courbe de tendance entre Aucun, Linéaire, Logarithmique, Exponentielle et 
Puissance. Vous pouvez également choisir d'afficher l'équation pour la courbe de tendance et le 
coefficient de détermination (R²).

Pour insérer une courbe de tendance pour une seule série de données, sélectionnez d'abord la 
série de données dans le diagramme, puis choisissez Insertion > Courbe de tendance, ou faites 
un clic droit et choisissez Insérer une courbe de tendance dans le menu contextuel. La boîte de 
dialogue est identique à celle ci-dessous, mais a un second onglet (Ligne), où vous pouvez choisir 
les attributs (style, couleur, largeur et transparence) de la ligne.

Figure 11 : Boîte de dialogue Courbes de tendance

La courbe de tendance est automatiquement insérée dans la légende.
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Pour supprimer une seule courbe de tendance ou une ligne de valeurs moyennes, cliquez sur la 
ligne et appuyez sur la touche Suppr, ou faites un clic droit sur la série de données puis choisissez 
Supprimer la courbe de tendance.

Pour supprimer toutes les courbes de tendance, choisissez Insertion > Courbe de tendance, 
puis cochez Aucun.

Si vous insérez une courbe de tendance dans un diagramme d'un type qui utilise des catégories, 
comme Ligne ou Colonne, alors les numéros 1, 2, 3, … sont utilisés comme valeurs X pour 
calculer la courbe de tendance.

La courbe de tendance a la même couleur que la série de données correspondante. Pour modifier 
les propriétés de la ligne, sélectionnez la courbe de tendance et choisissez Formater la courbe 
de tendance. La boîte de dialogue Courbe de tendance s'ouvre. Utilisez l'onglet Ligne.

Pour afficher l'équation de la courbe de tendance, sélectionnez la courbe de tendance dans le 
diagramme, faites un clic droit pour ouvrir le menu contextuel et choisissez Insérer l'équation de 
la courbe de tendance.

Quand le diagramme est en mode édition, LibreOffice vous donne l'équation de la courbe de 
tendance et le coefficient de corrélation. Cliquez sur la courbe de tendance pour voir l'information 
dans la barre d'état. Pour afficher l'équation et le coefficient de corrélation dans le graphique, 
sélectionnez la ligne et choisissez Insérer R2 et l'équation de la courbe de tendance.

Pour plus de détails sur les équations de régression, voir l'article Courbes de tendance dans les 
diagrammes dans l'Aide.

Courbes de valeur moyenne
Si vous sélectionnez Courbes de valeur moyenne dans le menu Insertion, Calc calcule la 
moyenne de chaque série de données sélectionnée et place une ligne de couleur au niveau 
correct dans le diagramme.

Barres d'erreur X ou Y
Si vous présentez des données qui ont une possibilité connue d'erreur, comme un sondage de 
société utilisant une méthode d'échantillonnage particulière, ou si vous voulez montrer la précision 
mesurée de l'outil que vous avez utilisé, vous pouvez souhaiter afficher des barres d'erreur dans le 
diagramme. Éditez le diagramme et choisissez Insertion > Barres d'erreur Y ou Insertion > 
Barres d'erreur X. Ces options ne sont disponibles qu'avec certains types de diagramme.

Plusieurs options sont proposées dans la boîte de dialogue Barres d'erreur X ou Y. Vous ne 
pouvez choisir qu'une option à la fois. Vous pouvez également choisir si l'indicateur d'erreur affiche 
les erreurs positives et négatives, ou seulement positives, ou seulement négatives.

• Valeur constante : vous pouvez avoir des valeurs positives et négatives différentes.

• Pourcentage : choisissez l'erreur comme un pourcentage des points de données.

• Dans la liste déroulante :

– Erreur type : calcule l'erreur selon les données numériques affichées dans le 
diagramme

– Écart type : montre l'erreur calculée selon l'écart type à partir du nombre de points de 
données et des valeurs respectives

– Variance : montre l'erreur calculée selon la variance à partir du nombre de points de 
données et des valeurs respectives

– Marge d'erreur : vous personnalisez l'erreur

• Plage de cellules : calcule l'erreur selon la plage de cellules que vous sélectionnez. La 
section Paramètres en bas de la boîte de dialogue se modifie pour permettre la sélection 
de plages de cellules.
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Figure 12 : Spécifier les paramètres des barres d'erreur

Formater les diagrammes

Le menu Format comporte plusieurs options pour formater et pour régler finement l'apparence de 
vos diagrammes.

Double-cliquez dans le diagramme pour qu'il soit entouré d'une bordure grise, ce qui indique qu'il 
est en mode édition ; puis sélectionnez l'élément de diagramme que vous voulez formater. 
Choisissez Format dans la barre de menus, ou faites un clic droit pour afficher le menu contextuel 
propre à l'élément sélectionné. Les options de formatage sont les suivantes.

Formater la sélection
Ouvre une boîte de dialogue dans laquelle vous pouvez spécifier le remplissage, les bordures, 
la transparence, les caractéristiques des textes, les effets de police et d'autres attributs des 
éléments sélectionnés du diagramme (voir page 19).

Position et taille
Ouvre une boîte de dialogue (voir page 22).

Disposition
Offre un choix : Envoyer vers l'avant ou Envoyer vers l'arrière. Pour certains éléments, un 
seul choix peut être actif. Utilisez cette option pour gérer l'ordre des séries de données ou le 
recouvrement d'éléments.

Titre
Formate les titres du diagramme et de ses axes.

Légende
Formate l'emplacement, les bordures, l'arrière-plan et le type de la légende.

Axe
Formate les lignes qui créent le diagramme, ainsi que la police du texte qui apparaît sur les 
axes X et Y.

Grille
Formate les lignes qui créent une grille pour le diagramme.

Paroi du diagramme, Plancher du diagramme, Arrière-plan du diagramme
Ces fonctions sont décrites dans les sections suivantes.
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Type de diagramme
Change le type de diagramme qui est affiché et s'il est à deux ou trois dimensions.

Plages de données
Expliquée page 7 (Figure 5 et Figure 6).

Affichage 3D
Formate les diagrammes 3D (voir page 16).

Note
Plancher du diagramme et Affichage 3D sont seulement disponibles pour les 
diagrammes 3D. Ces options sont inactives (grisées) si un diagramme 2D est 
sélectionné.

Dans la plupart des cas, vous aurez besoin de sélectionner l'élément exact que vous voulez 
formater. Parfois, il peut être délicat de le faire à l'aide de la souris, si le diagramme comporte 
beaucoup d'éléments, et particulièrement si certains d'entre eux sont petits ou se recouvrent. 
Utilisez dans ce cas la liste de sélection, le premier outil de la barre d'outils Formatage (Figure 4).

Si les Infobulles sont activées (dans Outils > Options > LibreOffice > Général, section Aide, 
sélectionnez Infobulles), et si alors vous déplacez la souris au-dessus de chaque élément, son 
nom apparaît dans l'Infobulle. Une fois que vous avez sélectionné un élément, vous pouvez 
appuyer sur Tab pour vous déplacer vers les autres éléments jusqu'à ce que vous trouviez celui 
que vous recherchez. Le nom de l'élément sélectionné apparaît dans la liste de sélection et dans 
la barre d'état.

Déplacer les éléments du diagramme
Vous pouvez souhaiter déplacer les éléments individuels d'un diagramme, indépendamment des 
autres éléments. Par exemple, vous pouvez souhaiter déplacer la légende à un autre endroit. Les 
diagrammes de type secteur permettent le déplacement individuel de chaque secteur (en plus du 
choix d'éclater tous les secteurs). En revanche, il n'est pas possible de déplacer individuellement 
un point ou une série de données.

Pour déplacer un élément, placez le curseur de la souris au-dessus de lui. Lorsque le curseur 

devient le symbole de déplacement , vous pouvez cliquer et faire glisser l'élément pour le 
déplacer.

Note

Si votre diagramme est 3D, cliquer sur la paroi du diagramme fait apparaître des 
poignées rondes rouges pour contrôler l'aspect tridimensionnel du graphique. Vous 
ne pouvez pas redimensionner ou repositionner le graphique tant que ces poignées 
rouges apparaissent. Si les poignées rouges sont visibles, faites Maj+Clic pour 
obtenir les poignées vertes de redimensionnement. Vous pouvez alors 
redimensionner et repositionner votre graphique 3D.

Changer l'arrière-plan de la zone du diagramme
La zone du diagramme est la zone qui entoure le graphique du diagramme, incluant le titre 
principal (optionnel) et la légende.

1) Double-cliquez dans le diagramme pour qu'il soit entouré d'une bordure grise.

2) Choisissez Format > Arrière-plan du diagramme ou faites un clic droit dans la zone du 
diagramme et choisissez Formater la zone du diagramme.

3) Dans la boîte de dialogue Zone du diagramme, choisissez les options voulues.

Dans l'onglet Remplissage, vous pouvez changer la couleur ou choisir un motif de hachure, un 
bitmap ou des dégradés prédéfinis. Cliquez dans la liste déroulante pour voir les options.
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Vous pouvez également utiliser l'onglet Transparence pour changer la transparence de la zone. Si 
vous utilisez un dégradé prédéfini dans l'onglet Remplissage, vous pouvez voir les différents 
paramètres qui le composent.

Figure 13 : Boîte de dialogue Zone du diagramme

Changer l'arrière-plan de la paroi du diagramme
La paroi du diagramme est la zone qui contient le graphique du diagramme (non disponible pour 
les type Secteurs et Toile).

1) Double-cliquez dans le diagramme pour qu'il soit entouré d'une bordure grise.

2) Choisissez Format > Paroi du diagramme ou faites un clic droit dans le diagramme et 
choisissez Formater la paroi. La boîte de dialogue Paroi du diagramme a les mêmes 
options de formatage que dans “Changer l'arrière-plan de la zone du diagramme” ci-
dessus.

3) Choisissez vos paramètres et cliquez sur OK.

Changer les couleurs
Si vous avez besoin d'une palette de couleurs différente de celle par défaut dans tous vos 
documents, allez à Outils > Options > Diagrammes > Couleurs par défaut, où vous pourrez 
associer des couleurs aux séries de données. Les changements que vous ferez ici affecteront les 
couleurs par défaut de tous les diagrammes que vous ferez à l'avenir.

Formater les diagrammes 3D

Utilisez Format > Affichage 3D pour régler finement les diagrammes 3D. La boîte de dialogue 
Affichage 3D a trois onglets, où vous pouvez changer la perspective du diagramme, déterminer si 
le diagramme utilise des schémas simples ou réalistes ou vos propres schémas, et l'éclairage qui 
contrôle les ombres.

Rotation et perspective
Pour faire tourner un diagramme 3D ou le voir en perspective, saisissez les valeurs voulues dans 
l'onglet Perspective de la boîte de dialogue Affichage 3D. Vous pouvez également faire tourner les 
diagrammes 3D de manière interactive ; voir page 19.
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Figure 14 : Faire tourner un diagramme

Voici quelques astuces pour utiliser l'onglet Perspective :

• Paramétrez tous les angles à 0 pour une vue frontale du diagramme. Les diagrammes de 
type secteur et tore sont affichés comme des cercles.

• Avec Axes à angle droit coché, vous ne pouvez faire tourner le contenu du diagramme que 
dans les directions X et Y ; c'est-à-dire, parallèlement aux bordures du diagramme.

• Une valeur X de 90, avec Y et Z mis à 0, fournit une vue depuis le dessus du diagramme. 
Avec X à –90, la vue est depuis le dessous du diagramme.

• Les rotations sont appliquées dans l'ordre suivant : X en premier, puis Y et enfin Z.

• Quand l'ombrage est actif et que vous faites tourner le diagramme, l'éclairage tourne 
comme s'il était fixé au diagramme.

• Les axes de rotation se réfèrent toujours à la page, et non aux axes du diagramme. C'est 
une différence par rapport à certains autres programmes de graphiques.

• Cochez l'option Perspective pour voir le diagramme dans une perspective centrale, comme 
à travers la lentille d'un objectif, au lieu d'une projection parallèle.

Fixez la longueur de focale dans le champ près de l'option Perspective (elle devient active 
quand vous cochez l'option). 100% donne une vue en perspective où le côté éloigné du 
diagramme paraît à peu près moitié moins que le côté proche.

Apparence
Utilisez l'onglet Apparence pour modifier certains aspects de l'apparence d'un diagramme 3D.

Sélectionnez un jeu dans la liste déroulante. Quand vous sélectionnez un jeu, les options et les 
sources d'éclairage sont paramétrées en fonction de vos desiderata. Si vous sélectionnez ou dé-
sélectionnez un ensemble d'options qui ne correspondent pas aux jeux Simple ou Réaliste, vous 
pouvez créer un jeu Personnalisé (ce choix s'ajoute alors à la liste).

Cochez Ombrage pour utiliser la méthode Gouraud pour le rendu des surfaces. Sinon, un 
ombrage plat est utilisé. L'ombrage plat établit une seule couleur et une seule brillance pour 
chaque polygone. Les bords sont visibles, les dégradés progressifs mais les points d'éclairage ne 
sont pas possibles. Référez vous au Guide Draw pour plus de détails sur l'ombrage.

Cochez Bordures d'objet pour tracer des lignes le long des côtés.

Cochez Arrondi d'arêtes pour adoucir les côtés des formes des boîtes. Dans certains cas, cette 
option n'est pas disponible.
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Figure 15: Modifier l'apparence d'un diagramme 3D

Éclairage
Utilisez l'onglet Éclairage (Figure 16) pour déterminer les sources d'éclairage pour l'affichage 3D. 
Référez vous au Guide Draw pour plus de détails sur l'éclairage.

Figure 16 : Paramétrer l'éclairage

Cliquez sur l'un des huit boutons pour allumer ou éteindre une source directe de lumière. Par 
défaut, la deuxième source de lumière est allumée. Les sources de lumière deux à huit sont 
normales et uniformes. La première source de lumière projette une lumière spéculaire avec des 
surbrillances.

Pour la source de lumière sélectionnée, vous pouvez alors choisir la couleur et l'intensité dans la 
liste juste en-dessous des huit boutons. Les valeurs de brillance de toutes les lumières sont 
additionnées, utilisez donc des couleurs sombres quand vous activez plusieurs lumières.

Chaque source de lumière pointe toujours initialement au milieu de l'objet. Pour changer la position 
de la source de lumière, utilisez la petite pré-visualisation de cet onglet. Elle a deux curseurs pour 
déterminer la position horizontale et verticale de la source de lumière sélectionnée. 

Le bouton au coin de la petite pré-visualisation permet de basculer le modèle d'éclairage interne 
entre une sphère et un cube.
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Utilisez la liste Lumière ambiante pour définir la lumière ambiante qui brillera d'une intensité 
uniforme dans toutes les directions.

Faire tourner les diagrammes 3D de manière interactive
En plus de l'utilisation de l'onglet Perspective de la boîte de dialogue Affichage 3D, vous pouvez 
faire tourner les diagrammes 3D de manière interactive.

Sélectionnez la Paroi du diagramme, puis placez le pointeur de la souris au-dessus d'une poignée 
de coin ou sur le symbole de rotation qui se trouve au milieu de la grille d'information du 
diagramme. Le curseur devient l'icône de rotation.

Appuyez et gardez appuyé le bouton gauche de la souris et faites glisser le coin dans la direction 
désirée. Un contour en pointillés du diagramme est visible pendant que vous faites glisser, pour 
vous aider à visualiser l'aperçu du résultat.

Formater les éléments du diagramme

Selon le but de votre document, une présentation à l'écran ou un document imprimé pour une 
publication en noir et blanc par exemple, vous pouvez vouloir utiliser un contrôle plus détaillé des 
différents éléments du diagramme pour obtenir ce que vous voulez.

Pour formater un élément, cliquez sur l'élément que vous voulez changer, un des axes par 
exemple. L'élément sera mis en évidence avec des carrés verts. Faites alors un clic droit et 
choisissez une option dans le menu contextuel. Chaque élément de diagramme a sa propre 
sélection d'options. Dans les sections suivantes, nous allons voir certaines de ces options.

Formater les axes et insérer des grilles
Parfois vous avez besoin d'avoir une échelle spéciale pour l'un des axes de votre diagramme, ou 
vous avez besoin d'intervalles de grilles plus petits, ou vous voulez changer le formatage des 
étiquettes des axes. Après avoir mis en surbrillance l'axe que vous voulez changer, faites un clic 
droit et choisissez l'une des options du menu contextuel.

Le choix de Format > Axe > Axe X ou Format > Axe > Axe Y ouvre la boîte de dialogue de la 
Figure 17. Les champs valides dans cette boîte de dialogue dépendent du type de diagramme et 
s'il est 2D ou 3D.

Dans l'onglet Échelle, vous pouvez choisir une échelle logarithmique ou linéaire (défaut), combien 
de marques vous avez besoin sur la ligne, où les marques doivent apparaître et les incréments 
(intervalles) de l'échelle. Vous devez tout d'abord décocher l'option Automatique afin de pouvoir 
modifier la valeur pour chaque échelle. Cocher Inverser la direction crée une représentation 
inversée du diagramme.

Figure 17 : Formater l'échelle des axes
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Dans l'onglet Étiquette (Figure 18), vous pouvez choisir d'afficher ou de masquer les étiquettes, 
comment les disposer quand elles ne s'alignent pas parfaitement sur une seule ligne (par exemple, 
si les mots sont trop longs), et de les disposer avec un angle d'orientation.

Figure 18 : Formater les étiquettes des axes

L'onglet Positionnement vous permet de déterminer où la ligne de l'axe croise l'autre axe et la 
position des étiquettes et des marques d'intervalle.

Les autres onglets de la boîte de dialogue, Ligne, Nombres, Police et Effets de caractère, sont 
relativement évidents. L'onglet Ligne regroupe les attributs de la ligne utilisée pour l'axe. L'onglet 
Nombres vous permet de déterminer les attributs de style de nombres utilisés. Police et Effets de 
caractère vous permettent de formater, entre autres, le type, la taille, la couleur et le style de 
police.

Formater les étiquettes de données
Vous pouvez choisir les propriétés pour les étiquettes des séries de données. Cliquez sur l'élément 
du diagramme, puis faites un clic droit et choisissez la propriété que vous voulez changer. 
Choisissez la commande Formater les étiquettes de données, ce qui ouvre une boîte de 
dialogue avec plusieurs onglets où vous pouvez changer la couleur du texte de l'étiquette, la taille 
de la police et d'autres attributs. L'onglet Étiquettes de données est montré Figure 10.

Dans l'onglet Étiquettes de données, vous pouvez choisir de :

• Afficher les valeurs numériques en tant que nombre ou en tant que pourcentage

• Afficher un texte dans les étiquettes (catégorie)

• Inclure le symbole de légende dans l'étiquette

Ces options sont les mêmes que celles de la Figure 10 page 11.

Le texte dans les étiquettes provient des étiquettes des colonnes et ne peut être modifié ici. S'il 
faut que le texte soit abrégé, ou s'il n'étiquette pas votre graphique comme vous l'espériez, vous 
devez le changer dans la table de données d'origine.

Étiquettes d'axes hiérarchiques
Les multiples colonnes de catégories sont affichées de manière hiérarchique sur les axes comme 
indiqué. Pour l'obtenir automatiquement quand vous créez un diagramme, assurez-vous que 
toutes les premières colonnes (ou lignes) contiennent du texte et pas seulement des nombres. 
Vous pouvez également choisir de déterminer les plages pour les catégories dans plusieurs 
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colonnes dans l'onglet Séries de données de l'Assistant ou de la boîte de dialogue Plage de 
données.

Choisir et formater les symboles
Pour les diagrammes ligne et XY, les symboles représentant les points peuvent être modifiés en 
forme et en couleur à travers la boîte de dialogue des propriétés de l'objet. Sélectionnez la série 
de données que vous voulez changer, faites un clic droit et choisissez Formater les séries de 
données dans le menu contextuel.

Dans l'onglet Ligne de la boîte de dialogue Séries de données, dans la section Icône, choisissez 
dans la liste déroulante Sélectionner > Symboles. Ici vous pouvez choisir aucun symbole, un 
symbole dans une sélection pré-définie, une plus grande variété dans la Gallery, ou si vous avez 
des images que vous voulez utiliser, vous pouvez les insérer en utilisant Sélectionner > À partir 
d'un fichier.

Figure 19 : Sélection des symboles
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Ajouter des objets dessinés aux diagrammes

Comme pour les autres composants LibreOffice, vous pouvez utiliser la barre d'outils de dessin 
pour ajouter des formes simples comme des lignes, des rectangles, des objets textes, ou des 
formes plus complexes comme des symboles ou des formes flèches. Utilisez ces formes 
supplémentaires pour ajouter des notes d'explication à votre diagramme, par exemple.

Pour formater des objets dessinés, faites un clic droit et choisissez une commande dans le menu 
contextuel.

Redimensionner et déplacer le diagramme

Vous pouvez redimensionner ou déplacer tous les éléments d'un diagramme à la fois, de deux 
manières : interactive ou en utilisant la boîte de dialogue Position et taille. Vous pouvez combiner 
les deux méthodes : interactive pour les changements faciles et rapides, puis la boîte de dialogue 
pour une dimension et une position précises.

Pour redimensionner un diagramme de manière interactive :

1) Cliquez dans le diagramme pour le sélectionner. Les poignées vertes de dimensionnement 
apparaissent autour du diagramme.

2) Pour augmenter ou diminuer la taille du diagramme, cliquez et faites glisser l'un des 
marqueurs. Pour conserver le ratio entre hauteur et largeur, maintenez la touche Maj 
appuyée pendant cette opération.

Pour déplacer un diagramme de manière interactive :

1) Cliquez dans le diagramme pour le sélectionner. Les poignées vertes de dimensionnement 
apparaissent autour du diagramme.

2) Déplacez le pointeur de la souris au-dessus du diagramme. Quand il se change en icône 

de déplacement , cliquez et faites glisser jusqu'à sa nouvelle position.

3) Relâchez le bouton de la souris quand l'élément est dans la position voulue.

Utiliser la boîte de dialogue Position et taille
Pour redimensionner ou déplacer un diagramme en utilisant la boîte de dialogue Position et taille :

1) Cliquez dans le diagramme pour le sélectionner. Les poignées vertes de dimensionnement 
apparaissent autour du diagramme.

2) Faites un clic droit et choisissez Position et taille dans le menu contextuel.

3) Faites vos choix dans cette boîte de dialogue.

La position est définie par des coordonnées X et Y relatives à un point fixe (le point de base), 
ordinairement situé en haut et à gauche du document. Vous pouvez temporairement changer ce 
point de base pour rendre le positionnement ou le dimensionnement plus simple (cliquez sur 
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l'endroit à l'emplacement du point de base dans l'une des deux fenêtres de sélection du côté droit 
de la boîte de dialogue, en haut pour le positionnement et en bas pour le dimensionnement).

Figure 20 : Définir la position et la taille d'un objet

Les positions possibles du point de base correspondent aux poignées du cadre de sélection, plus 
un point central. Le changement de position dure tant que la boîte de dialogue est ouverte ; quand 
vous fermez cette boîte, Calc réinitialise le point de base dans sa position standard.

Astuce
L'option Proportionnel est très utile. Cochez la pour conserver le ratio entre 
largeur et hauteur quand vous changez la taille d'un objet.

La taille ou la position, ou les deux, peuvent être protégées pour qu’elles ne puissent être 
modifiées accidentellement. Cochez les options correspondantes.

Astuce Si vous ne pouvez pas déplacer un objet, vérifiez si sa position n'est pas protégée.

Galerie des types de diagramme

Il est important de garder à l'esprit que si vos données peuvent être présentées par plusieurs 
diagrammes différents, le message que vous voulez délivrer va déterminer le diagramme que vous 
allez finalement utiliser. Les sections suivantes présentent des exemples de types de diagramme 
que Calc peut fournir, avec quelques améliorations possibles et des notes sur les buts que vous 
pouvez avoir pour chaque type. Pour plus de détails, voir l'index de l'Aide.

Colonne
Les diagrammes de type Colonne sont fréquemment utilisés pour des données qui montrent des 
tendances dans la durée. Ils sont indiqués pour des diagrammes qui ont relativement peu de 
points de données. (Pour des plus grandes séries dans la durée, une ligne est préférable.) C'est le 
type de diagramme par défaut, et c'est l'un des diagrammes les plus utiles et les plus faciles à 
comprendre.
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Barre

Figure 21 : Trois graphiques de type Barre
 

Les diagrammes de type Barre sont excellents pour fournir un impact visuel immédiat d'une 
comparaison de données dans les cas où le temps n'est pas un facteur important, par exemple 
pour comparer la popularité de quelques produits d'un lieu de vente donné.

• Le premier diagramme est réalisé très simplement en utilisant l'assistant, en modifiant les 
axes X et Y et en utilisant Insertion > Courbes de valeur moyenne.

• Le deuxième diagramme comprend l'option 3D de l'assistant avec une bordure simple et 
une rotation du diagramme 3D.

• Le troisième diagramme illustre comment se passer de légende en insérant les valeurs et 
des étiquettes sur l'axe pour afficher le nom des produits. Les couleurs ont été également 
transformées en hachures.

Secteur
Les diagrammes de type Secteur sont excellents quand vous avez besoin de comparer des 
proportions. Par exemple, un diagramme de type secteur est idéal pour montrer une comparaison 
des dépenses d'établissements, ce qu'un établissement a dépensé en différents produits ou ce 
que différents établissements ont dépensé. Ces diagrammes fonctionnent mieux avec un petit 
nombre de valeurs, pas plus d'une demi-douzaine. L'impact visuel diminue avec plus de valeurs.

Figure 22 : Diagrammes de type Secteur

Même si l'Assistant de diagramme devine les séries que vous voulez inclure dans vos secteurs, 
vous pouvez avoir besoin de l'ajuster dans la page Plage de données de l'Assistant ou en utilisant 
la boîte de dialogue de Format > Plages de données > Séries de données.
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Vous pouvez faire des choses intéressantes avec des secteurs, plus particulièrement avec un 
diagramme 3D. Vous pouvez l'incliner, lui donner des ombres et plus généralement en faire 
pratiquement une œuvre d'art. Ne l'encombrez cependant pas trop afin de ne pas égarer votre 
message, et faites attention à ce que l'inclinaison ne distorde pas la proportion des secteurs.

Vous pouvez choisir l'option dans L'assistant de diagramme pour éclater les secteurs, mais c'est 
une option tout ou rien. Si votre but est de mettre en évidence un secteur de l'ensemble, vous 
pouvez le séparer en le sélectionnant soigneusement une fois que vous avez terminé l'Assistant 
de diagramme, et en le faisant glisser en dehors du groupe. Quand vous faites ceci, il est peut-être 
nécessaire d'agrandir à nouveau le diagramme pour retrouver la taille d'origine des secteurs.

Les effets obtenus Figure 22 sont expliqués ci-dessous.

• Le premier exemple est un secteur 2D avec un secteur de l'ensemble éclaté. Pour produire 
ce type de diagramme, choisissez tout d'abord Insertion > Légende et décochez Afficher la  
légende. Choisissez Insertion > Étiquettes de données et cochez Afficher la valeur sous 
forme de nombre et Afficher la catégorie. Puis sélectionnez soigneusement le secteur que 
vous voulez mettre en évidence en plaçant le curseur au-dessus, cliquez (le secteur aura 
des carrés verts pour l'indiquer), et faites-le alors glisser hors de l'ensemble des autres 
secteurs. La taille de secteurs va diminuer, vous devrez peut-être alors sélectionner le 
diagramme et faire glisser un de ses coins pour augmenter sa taille.

• Le deuxième exemple est un diagramme secteur 3D avec un schéma réaliste et un 
éclairage. À partir d'un diagramme secteur 2D terminé, passez le en 3D et choisissez 
Format > Affichage 3D > Éclairage où vous pouvez modifier la direction de l'éclairage, la 
couleur de la lumière ambiante et la profondeur de l'ombre. Vous pouvez également ajuster 
l'angle 3D du disque dans l'onglet Perspective de cette boîte de dialogue.

Le diagramme se met à jour dès que vous effectuez les modifications, vous pouvez donc 
voir immédiatement leurs effets.

Si vous voulez séparer l'un des secteurs, cliquez soigneusement sur celui-ci ; vous devriez 
voir un cadre en pointillés pour le mettre en évidence. Faites le glisser avec la souris, puis, 
si nécessaire, augmentez la taille du diagramme.

• Le troisième exemple est un diagramme secteur 3D avec différents effets de remplissage 
pour chaque secteur du disque. Choisissez Insertion > Étiquettes de données et cochez 
Afficher la valeur sous forme de pourcentage. Sélectionnez soigneusement chacun des 
secteurs pour que leur cadre en pointillés apparaisse, puis faites un clic droit et choisissez 
Formater le point de données pour obtenir la boîte de dialogue des propriétés de l'objet. 
Choisissez l'onglet Remplissage. Pour un des secteurs, nous avons choisi un effet bitmap, 
pour un autre nous avons sélectionné un dégradé et pour le troisième, nous avons utilisé 
l'onglet Transparence et ajusté la transparence à 50 %.
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Tore
Les diagrammes de type Tore sont une variante du type Secteur permettant de représenter des 
colonnes de données multiples. Pour en créer un, choisissez Secteur en tant que type de 
diagramme, puis choisissez le troisième ou le quatrième type de diagramme secteur. Pour plus de 
possibilités, cochez 3D.

Figure 23 : Choisir un diagramme de type Tore

Figure 24 : Exemples de diagrammes de type Tore
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Zone
Un diagramme de type Zone est une version d'un graphique ligne ou colonne. Il peut être utile 
quand vous souhaitez mettre en évidence le volume des changements. Les diagrammes Zone ont 
un plus grand impact visuel qu'un diagramme ligne, mais les données que vous représentez 
peuvent influer sur le choix du type.

Figure 25 : Diagrammes de type Zone : le bon et le moins bon

Comme montré Figure 25, un diagramme de type zone est parfois délicat à utiliser. Ce peut être 
une bonne raison d'utiliser les valeurs de transparence dans un diagramme zone. Après avoir 
paramétré le diagramme de base dans l'Assistant de diagramme, effectuez les manipulations 
suivantes :

• Faites un clic droit sur l'axe Y et choisissez Supprimer la grille principale. Comme les 
données se recouvrent, certaines d’entre elles sont perdues derrière la première série de 
données. Ce qui n'est pas souhaitable. Le deuxième diagramme est meilleur.

• Après avoir supprimé la grille de l'axe Y, faites un clic droit sur chacune des séries de 
données et choisissez Formater les séries de données. Dans l'onglet Transparence, 
passez la Transparence à 50%. La transparence facilite la visualisation des données 
cachées derrière la première série. Faites ensuite un clic droit sur l'axe X et choisissez 
Formater l'axe. Dans l'onglet Étiquette, choisissez Juxtaposer dans la section Disposition 
et fixez l'Orientation du texte à 55 degrés. Ceci va placer les étiquettes avec un angle.

• Pour créer la troisième variante, après avoir fait les étapes ci-dessus, faites un clic droit et 
choisissez Type de diagramme. Cochez 3D et sélectionnez Réaliste dans la liste 
déroulante. Nous avons également fait pivoter le diagramme et donné à la paroi du 
diagramme l'image du ciel. Les étiquettes de l'axe Z rendent la légende superflue. Mais, 
bien que le diagramme soit visuellement plus attractif, il est plus difficile de voir la 
signification des données.

Le diagramme zone empilé et le diagramme zone pourcentage empilé sont d'autres façons de 
représenter les mêmes séries de données.
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Figure 26 : Diagramme zone empilé et pourcentage empilé

Le premier fait ce qu'il dit : chaque nombre de chaque série est ajouté aux autres ; ainsi, c'est le 
volume total qui est montré et non une comparaison des données. Le diagramme pourcentage 
empilé montre chaque valeur dans les séries comme une partie d'un tout. Dans cet exemple, les 
trois valeurs sont additionnées et le résultat représente 100% pour chaque mois. Les valeurs 
individuelles sont un pourcentage de cela. Beaucoup de diagrammes ont des variantes qui ont 
cette option.

Ligne
Un diagramme de type Ligne est une série dans le temps avec une progression. Il est idéal pour 
les données brutes, et utile pour les diagrammes avec beaucoup de données qui affichent des 
tendances ou des évolutions dans le temps et où vous voulez mettre en évidence la continuité. 
Dans les diagrammes de type ligne, l'axe X est idéal pour être la série de données temps.

Figure 27 : Diagrammes de type ligne

Vous pouvez entre autres épaissir les lignes, les passer en 3D, lisser leurs contours ou les effacer 
pour ne conserver que les points.

Les lignes en 3D sont souvent confuses pour le lecteur, et il est généralement préférable d'utiliser 
une ligne plus épaisse.
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Dispersion ou XY
Un diagramme XY, dans sa forme la plus simple, représente une série de données consistant en 
un nom, une liste de valeurs X et une liste de valeurs Y. Ils sont utiles pour mettre en évidence ou 
vérifier l'existence de corrélation, d'une relation entre ces valeurs. Chaque paire de valeurs est 
affichée comme un point dans un système de coordonnées. Le nom de la série de données est 
associé avec les valeurs et affiché dans la légende.

Les diagrammes de type Dispersion ou XY peuvent représenter plusieurs séries de données ; par 
exemple, des données météorologiques, les réactions à différents niveaux d'acidité, les conditions 
en altitude ou toutes autres données qui font correspondre deux séries de données numériques. 

L'exemple suivant Figure 28 montre un usage moins courant où l'on a représenté la plage A2:I5 
avec les options Première colonne comme étiquette et Plage de données > Séries de 
données en ligne. La première ligne de données contient les valeurs pour le Yen auxquelles sont 
comparées les trois autres devises. Le Yen JPY n'apparaît donc pas en tant que tel ; il est 
simplement utilisé comme une série de constantes avec lesquelles les autres séries de données 
sont comparées.

Figure 28 : Une période particulièrement volatile pour le marché mondial des devises
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Bulles
Un diagramme de type Bulle est une variante du diagramme dispersion dans lequel les points de 
données sont remplacés par des bulles. Il montre les relations entre trois variables en deux 
dimensions. Deux variables sont utilisées pour la position sur les axes X et Y, tandis que la 
troisième est indiquée par la taille relative de chaque bulle. Une ou plusieurs séries de données 
peuvent être comprises dans un seul diagramme.

Si la série de données de l'axe X est constituée de textes, c'est un numéro d'ordre qui figurera 
comme étiquette de cet axe. Dans le cas contraire, les données de la série sont utilisées pour le 
positionnement selon l'axe X, ce qui peut conduire à des bulles irrégulièrement espacées, comme 
Figure 29.

Les diagrammes bulle sont souvent utilisés pour présenter des données financières. Le champ 
Plages de données a une entrée pour définir la plage de données des bulles et de leur taille.

Figure 29 : Diagramme de type bulle montrant trois séries de données

Toile
Un diagramme de type Toile est similaire à un diagramme polaire ou radar. Il est utile pour 
comparer des données qui ne sont pas dans une série de temps mais dans des circonstances 
différentes, comme des variables dans une expérience scientifique ou des directions. Les pôles 
d'un diagramme toile sont l'équivalent de l'axe Y des autres diagrammes. Généralement, le mieux 
est d'avoir entre trois et huit axes ; plus d'axes et ce type de diagramme devient confus. Les 
valeurs avant et après peuvent être tracées sur le même diagramme, ou les résultats prévus et 
réalisés, pour que les différences puissent être comparées.

La Figure 30 montre deux types de diagrammes toile :

• (Gauche) : Diagramme toile simple sans grilles ni lignes, seulement des points.

• (Droite) : Diagramme toile avec des lignes, des points et une grille. Les couleurs des axes 
et les étiquettes ont été modifiées. La couleur de la zone de diagramme a été changée 
avec un dégradé. Les points de ce graphique ont été changés en sphères 3D fantaisie.
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Figure 30 : Deux diagrammes de type Toile

D'autres variantes d'un diagramme de type toile peuvent être mises en place pour montrer les 
séries de données en tant que nombres empilés ou pourcentages empilés. Les séries peuvent 
également être remplies par une couleur (Figure 31). Une transparence partielle est souvent 
préférable pour montrer toutes les séries en une fois.

Figure 31 : Diagramme toile ou radar avec 
remplissage

Cours
Un diagramme de type Cours est un graphique en colonnes spécialisé pour la bourse et les 
actions. Dans ce type de diagramme, l'axe X représente une série temps. Les données 
nécessaires pour ces diagrammes sont très particulières, avec des séries pour le prix à l'ouverture, 
le prix à la fermeture et les prix maximum et minimum. Choisissez parmi les quatre types proposés 
en fonction des données disponibles :
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• Type 1 : Bas, Haut, Clôture

• Type 2 : Ouverture, Bas, Haut, Clôture

• Type 3 : Volume, Bas, Haut, Clôture

• Type 4 : Volume, Ouverture, Bas, Haut, Clôture

Selon le cas, vous obtiendrez des Graphiques en barres ou des Chandeliers.

Pour ne pas être obligé de réaffecter les plages de données aux différentes valeurs, il est conseillé 
d'ordonner les colonnes dans l'ordre de la Figure 32. Si ce n'est pas possible, il est important de 
définir précisément les plages de données de la page Séries de données pour obtenir un 
diagramme significatif. Vous devez préciser quelle série représente le prix à l'ouverture, le prix à la 
fermeture, les prix maximum et minimum de l'action, et ainsi de suite.

Figure 32 : Ajuster les séries de données pour les diagrammes de type Cours
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Un point agréable est que les diagrammes de type cours de LibreOffice ont un code couleur pour 
les actions qui montent et qui descendent : blanc pour monter, noir pour descendre dans le 
diagramme chandelier, et rouge et bleu dans le diagramme avec les lignes traditionnelles.

Colonne et ligne
Un diagramme de type Colonne et ligne est une combinaison de deux autres types de 
diagrammes. Il est utile pour combiner deux séries de données distinctes mais liées comme les 
coûts de production dans le temps (colonne) avec l'évolution des marges (ligne).

Vous pouvez choisir le nombre de colonnes et de lignes dans l'Assistant de diagramme. Vous 
pourriez ainsi par exemple avoir deux colonnes et deux lignes pour représenter deux lignes de 
produits, avec pour chacune les coûts et la marge.

Le diagramme de la Figure 33 comporte les coûts de production et la marge pour deux produits, 
pendant une période de temps (le 1er semestre). Pour créer ce diagramme, sélectionnez tout 
d'abord le tableau et démarrez l'Assistant de diagramme. Choisissez le type de diagramme 
Colonne et ligne avec deux lignes et les séries de données en lignes. Puis donnez un titre pour 
mettre en évidence l'aspect que vous voulez montrer. Les lignes ont des couleurs différentes à 
cette étape et ne reflètent pas le fait que c'est le même produit. Une fois terminé avec l'Assistant 
de diagramme, sélectionnez le diagramme, cliquez sur la ligne, faites un clic droit et choisissez 
Formater les séries de données.

Dans cet onglet, il y a plusieurs choses à changer : les couleurs doivent correspondre. Ainsi, le 
coût de fabrication et la marge du produit P1 sont bleus et les valeurs du produit P2 sont rouges. 
Si les lignes ne sont pas assez visibles, augmentez leur épaisseur à 0,05.

Figure 33 : Diagramme de type Colonne et ligne

Pour l'arrière-plan, sélectionnez la paroi du diagramme, faites un clic droit et choisissez Formater 
la paroi. Dans l'onglet Remplissage, choisissez Dégradé dans la liste déroulante. Choisissez 
également un des dégradés pré-définis et rendez le plus léger en allant dans l'onglet 
Transparence et afin de rendre le dégradé transparent à 50 %.

Pour rendre le diagramme plus propre sans la grille, allez à Insertion > Grilles et décochez l'axe 
X.
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